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Administratorhandbuch

Die folgenden Anweisungen gelten fiir Administratoren an Standorten mit dem Lizenztyp Lizenz fiir
gleichzeitig angemeldete Benutzer fiir IBM® SPSS Statistics 25. Mit dieser Lizenz kénnen Sie IBM SPSS
Statistics auf beliebig vielen Computern installieren. Allerdings hdngt die Anzahl der Benutzer, die die
Anwendung gleichzeitig ausfiihren kénnen, davon ab, fiir wie viele Personen die Lizenz erworben wur-
de.

Vorbereitungen

Sie benétigen Thren Autorisierungscode. Mit dem Autorisierungscode konnen Sie eine Lizenz fiir den
Concurrent License Manager abrufen. Der Concurrent License Manager steuert die Lizenz fiir gleichzei-
tig angemeldete Benutzer und ermdglicht den Endbenutzern die Ausfiihrung von IBM SPSS Statistics.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie den
Autorisierungscode nicht finden konnen, wenden Sie sich an den Kundendienst. Rufen Sie hierzu die Sei-
te |http:/ /www.ibm.com /software /analytics /spss/support/clientcare.html| auf.

Fiihren Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz fiir gleichzeitig angemelde-
te Benutzer ordnungsgemafs eingerichtet haben:

1. Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-
programm, das Endbenutzern die Lizenz fiir gleichzeitig angemeldete Benutzer bereitstellt. Sie konnen
den Lizenzmanager auf einem beliebigen Computer in Ihrem Netz speichern. In der Regel handelt es
sich dabei um einen Server, an den Desktop-Computer angeschlossen werden kénnen. Weitere Infor-
mationen finden Sie in |, Installieren des Concurrent License Managers” auf Seite 2|

2. Lizenzieren Sie das Produkt. Mit diesem Vorgang erhilt der Lizenzmanager die fiir die Ausgabe der
Lizenzen erforderlichen Informationen. Weitere Informationen finden Sie in |, Produktlizenzierung” auf|

3. Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie in |,,Testen des Lizenzmanagers”|

4. Installieren Sie IBM SPSS Statistics auf den lokalen Desktop-Computern. Sie oder Ihre Endbenut-
zer fithren die vollstindige Installation auf den Desktop-Computern durch. Wahrend der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgefithrt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Statistics zu starten, fordert das Produkt bei diesem Lizenzmana-
ger einen Lizenzcode an. Wenn eine Lizenz verfiigbar ist, wird IBM SPSS Statistics gestartet. Weitere
Informationen finden Sie in |, Installieren des Produkts auf lokalen Desktop-Computern” auf Seite 8|

Fiir die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie in |, Verwalten der Lizenz fiir gleichzeitic angemeldete Benutzer” auf Seite 13| weitere Informa-
tionen.

Erstellen eines Image

Sie kénnen ein Image der Software erstellen, indem Sie den Lizenzmanager installieren und das Produkt
anschlieffend auf einem lokalen Desktop installieren, der zum Erstellen eines Images verwendet wird. Er-
stellen Sie nach Bedarf Images von zusatzlichen Computern.

Citrix- und Terminaldienste

Sie kénnen die Anwendung IBM SPSS Statistics auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Ser-
ver installieren und den Benutzern zugénglich machen, auf die Sie andere Anwendungen fiir Windows
installieren und zugénglich machen.


http://www.ibm.com/software/analytics/spss/support/clientcare.html

Gemischte Lizenzierung

IBM SPSS Statistics unterstiitzt gemischte Lizenzierungsumgebungen (eine Kombination aus lokalen Li-
zenzen fiir berechtigte Benutzer und Lizenzen fiir gleichzeitig angemeldete Benutzer) nur in einge-
schranktem Mafle. In einer typischen Umgebung werden sdmtliche Lizenzen entweder lokal oder iiber
den Concurrent License Manager verwaltet. Wenn das Hauptprodukt beispielsweise {iber den Concurrent
License Manager lizenziert ist, werden Zusatzmodule ebenfalls iiber den Concurrent License Manager li-
zenziert.

Eine gemischte Lizenzierung ist nur moglich, wenn das Hauptprodukt iiber den Concurrent License Ma-
nager lizenziert und die Zusatzmodule auf dem Computer des Endbenutzers mit licenseactivator lizenziert
werden. Installieren Sie IBM SPSS Statistics mit einer Lizenz fiir gleichzeitig angemeldete Benutzer, um
diese Art der gemischten Lizenzierung einzurichten. Verwenden Sie dann licenseactivator auf dem Compu-
ter des Endbenutzers, um die Zusatzmodule zu lizenzieren. Weitere Informationen zu licenseactivator fin-
den Sie in |,,Verwenden von 'licenseactivator' zur automatischen Installation einer Lizenz” auf Seite 6[

IBM SPSS Statistics unterstiitzt das umgekehrte Szenario nicht, bei dem das Hauptprodukt lokal und die
Zusatzmodule {iber den Concurrent License Manager lizenziert werden.

Installieren des Concurrent License Managers

Bevor Endbenutzer IBM SPSS Statistics auf ihrem Desktop-Computer installieren, miissen Sie den Con-
current License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgefiihrter Service
oder Damonprozess, der in der Regel auf einem Computer im Netz installiert wird. (Sie haben auch die
Moglichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrich-
ten miissen. Weitere Informationen finden Sie in |, Einrichten von redundanten Lizenzservern” auf Seite|
) Der Concurrent License Manager wird nicht auf den Desktop-Computern der Endbenutzer installiert.

Immer wenn ein Endbenutzer eine der Lizenz fiir gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Thnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurilickgewiesen. Wenn Sie feststellen, dass Endbenutzern haufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem fiir Sie zustindigen Héndler nach einer Lizenz fiir eine grofierer Anzahl
gleichzeitiger Benutzer.

Lizenzmanager sind auf einer separaten DVD/CD verfiigbar. Sie konnen auch als elmage heruntergela-
den werden.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen konnen. Weitere Informationen finden Sie in
Protokollinformationen” auf Seite 14}

Mehrere Betriebssysteme

Die Plattform, auf der der Concurrent License Manager ausgefiihrt wird, muss nicht mit der Plattform
tibereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen fiir
Windows-Clients bereitstellen.

Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur fiir Windows ver-

fiigbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benétigen, auf dem der Li-
zenzmanageradministrator installiert ist.
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Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss folgende Anforde-
rungen erfiillen. Fiir den Lizenzmanager ist kein Serverklassencomputer erforderlich.

* Prozessor mit mindestens 550 Mhz
¢ Mindestens 128 MB RAM

Wichtig: Wenn auf dem Computer, auf dem der Lizenzmanager installiert ist, eine Firewall aktiv ist,
miissen Sie Port 5093 fiir UDP 6ffnen. Andernfalls konnen die Client-Computer keine Lizenz vom Lizenz-
manager abrufen. Wenn Sie dartiiber hinaus redundante Lizenzmanagercomputer verwenden, miissen Sie
Port 5099 fiir UDP 6ffnen, damit die Lizenzmanagercomputer untereinander kommunizieren kénnen.

Durchfiihren eines Upgrades fiir den Lizenzmanager

Wenn Sie eine friihere Version des Lizenzmanagers installiert haben, miissen Sie die folgenden Schritte
durchfiihren:

1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
2. Kopieren Sie die Datei Iservrc. Windows: Suchen Sie im Verzeichnis winnt.

3. Speichern Sie die Datei Iservrc an einem sicheren Ort.
4

. Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-
gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie in
[, Konfigurieren von Pendlerlizenzen” auf Seite 16

5. Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie in |,Starten und Stoppen|
[des Lizenzmanagers” auf Seite 19}

6. Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie in |, Deinstallieren des|
[Lizenzmanagers” auf Seite 19|

7. Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
in [, Installieren des Lizenzmanagers unter Windows”} Informationen zum Installieren unter UNIX/
Linux finden Sie in |, Installieren des Lizenzmanagers unter anderen Betriebssystemen als Windows”|
auf Seite 4] Weitere Informationen zum Installieren unter Mac OS finden Sie in [, Installieren des Li-|
zenzmanagers unter Mac OS” auf Seite 4

8. Kopieren Sie die gespeicherte Datei Iservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie die Standardposition unter Windows akzeptiert haben, wechseln Sie in den Ordner
C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager\WinNT.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie miissen das Installationsprogramm als Administrator starten. Wenn Sie aufgefordert
werden, eine Installationsdatei zu starten, klicken Sie mit der rechten Maustaste auf die Datei und wahlen
Als Administrator ausfithren aus.

Anmerkung: Stellen Sie sicher, dass auf dem Computer, auf dem Sie die Installation durchfiihren, Java
installiert ist.

1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Kopieren Sie das Archiv, das
den Lizenzmanager und die Lizenztools fiir Inr Windows-Betriebssystem enthélt, von der DVD/CD.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren.

2. Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthilt.
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3.

4.

Fiihren Sie die Datei setup.exe im extrahierten Verzeichnis manager aus und folgen Sie den am Bild-
schirm angezeigten Anweisungen.

Fiihren Sie die Datei setup.exe im extrahierten Verzeichnis tools aus und folgen Sie den am Bild-
schirm angezeigten Anweisungen, um den Lizenzmanageradministrator auf demselben Computer wie
den Lizenzmanager zu installieren. Sie kdnnen den Lizenzmanageradministrator auch auf einem an-
deren Windows-Computer installieren, wenn Sie den Lizenzmanager remote verwalten mochten.

Installieren des Lizenzmanagers unter Mac OS

1.

Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie das Archiv, das
den Lizenzmanager und die Lizenztools fiir Ihr Betriebssystem enthiilt.

ODER:

Wenn Sie eine eImage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthélt, an dem
Speicherort, an dem Sie den Lizenzmanager installieren wollen.

Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie in |,Installieren des Lizenzmanageradministrators”}

Weitere Informationen zum Starten des Lizenzmanagers finden Sie in [, Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19|

Installieren des Lizenzmanagers unter anderen Betriebssystemen als
Windows

1.

Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie das Archiv, das
den Lizenzmanager und die Lizenztools fiir Ihr Betriebssystem enthalt.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthilt, an dem
Speicherort, an dem Sie den Lizenzmanager installieren wollen.

Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie in |, Installieren des Lizenzmanageradministrators”}

Weitere Informationen zum Starten des Lizenzmanagers finden Sie in [, Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19|

Installieren des Lizenzmanageradministrators

Der nur fiir Windows verfiigbare Lizenzmanageradministrator wird fiir die Verwaltung des Lizenzmana-
gers verwendet. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert haben, miis-
sen Sie den Lizenzmanageradministrator auf einem Windows-System installieren.

1.

4

Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Win-
dows-Netzcomputers ein, auf dem der Lizenzmanageradministrator ausgefiihrt werden soll. Kopieren
Sie das Archiv, das den Lizenzmanager und die Lizenztools enthélt, von der DVD/CD.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren.

Extrahieren Sie den Inhalt des Archivs, das den Lizenzmanager und die Lizenztools enthalt.

Fiihren Sie die Datei setup.exe im extrahierten Verzeichnis tools aus und folgen Sie den am Bild-
schirm angezeigten Anweisungen.
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Produktlizenzierung

Auf Nicht-Windows-Betriebssystemen miissen Sie die Lizenz nach der Installation des Lizenzmanagers
iiber die Eingabeaufforderung installieren.

Anmerkung: Lizenzen sind mit einem Sperrcode an die physische oder virtuelle Hardware des
Netzcomputers gebunden. Wenn Sie den Netzcomputer oder die zugehdrige Hardware austauschen, be-
notigen Sie einen neuen Sperrcode und miissen bei Threm Vertriebsbeauftragten einen neuen Autorisie-
rungscode anfordern. Bei Installationen auf einer virtuellen Maschine miissen Sie sicherstellen, dass Sie
einen Sperrcode auswihlen, der sich beim Neustart nicht dandert. Weitere Informationen finden Sie in
ktallieren einer Lizenz in einer virtuellen Umgebung”|

Wichtig: Die Lizenz reagiert auf Anderungen der Systemzeit. Wenn Sie die Systemzeit dndern miissen
und dann das Produkt nicht mehr ausfiihren konnen, fordern Sie Unterstiitzung durch das Kunden-
betreuungsteam tiiber die Seite lhttp:/ /www.ibm.com /software /analytics /spss/support/clientcare.html|
an.

Installieren einer Lizenz in einer virtuellen Umgebung

Es gibt spezielle Lizenzierungsanweisungen fiir Installationen des Concurrent License Managers in einer
virtuellen Umgebung. Bei einer virtuellen Maschine ist die Hardware virtuell und der Sperrcode, mit dem
der Lizenzmanager an die Lizenz gebunden ist, kann sich beim Neustart der virtuellen Maschine édndern.
Sie miissen einen Sperrcode finden, der sich beim Neustart der virtuellen Maschine nicht &ndert, um si-
cherzustellen, dass der Lizenzmanager ordnungsgemafS funktioniert. Wenn Sie einen stabilen Sperrcode
finden, verwenden Sie ihn fiir die Lizenzierung des Lizenzmanagers.

Wichtig:

Wenn Sie einen Sperrcode auswihlen, der sich beim Neustart dndert, funktioniert der Lizenzmanager
nicht mehr. Die IBM SPSS-Anwendung kann keine Lizenz abrufen und daher nicht gestartet werden.

Priifen des Sperrcodes
1. Offnen Sie eine Eingabeaufforderung.
2. Wechseln Sie in das folgende Verzeichnis.

* Windows. Das Installationsverzeichnis fiir den Lizenzmanageradministrator. Wenn Sie wahrend der
Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis fiir den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Too1s\9.7.0.0.

* Andere Plattformen. Das Installationsverzeichnis fiir den Lizenzmanager.
3. Geben Sie an der Eingabeaufforderung echoid (Windows) oder ./echoid (andere Plattformen) ein.

Es wird eine Ausgabe dhnlich der folgenden angezeigt:

G_ocking Code 1 : 4-12A1B )

Die unmittelbar vor dem Bindestrich (-) angezeigte Zahl ist das Sperrcodekriterium. Das Sperrcodekriteri-
um ist eine Zahl, die die virtuelle Hardware darstellt, die fiir den Sperrcode verwendet wird (in diesem
Beispiel ist dies 4 und stellt die Datensatz-ID des Datentrdgers mit dem Betriebssystem dar). Die Zahl
hinter dem Bindestrich ist der Sperrcode (in diesem Beispiel ist dies 12A1B).

Mogliche Sperrcodekriterien:

Sperrcodekriterium Virtuelle Hardware
2 IP-Adresse
4 Datensatz-ID des Datentrdgers mit dem Betriebssystem
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Sperrcodekriterium Virtuelle Hardware

8 Hostname

10 Ethernet-Karte

Prifen, ob der Sperrcode stabil ist
1. Starten Sie die virtuelle Maschine nach der Priifung des Sperrcodes neu.
2. Priifen Sie den Sperrcode erneut (siehe [ Priifen des Sperrcodes” auf Seite 5).

* Wenn sich der Sperrcode nicht dndert, starten Sie neu und priifen Sie den Sperrcode mehrmals.
Wenn der Sperrcode stabil ist, kénnen Sie die Lizenzierung durchfiihren (siehe |,Lizenzierung des|
[Lizenzmanagers mit dem neuen Sperrcode”).

« Wenn sich der Sperrcode d@ndert, miissen Sie ihn aktualisieren (siehe [, Aktualisierung des Sperr-|

feodes™).

Aktualisierung des Sperrcodes
1. Offnen Sie die Datei echoid.dat, die sich im folgenden Verzeichnis befindet, in einem Texteditor.

* Windows. Das Installationsverzeichnis fiir den Lizenzmanageradministrator. Wenn Sie wihrend der
Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis fiir den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Tool1s\9.7.0.0.

* Andere Plattformen. Das Installationsverzeichnis fiir den Lizenzmanager.

2. Es wird eine Hexadezimalzahl angezeigt, die das aktuelle Sperrcodekriterium darstellt. Andern Sie
diese Zahl in ein zuldssiges Sperrcodekriterium im Hexadezimalformat.

Sperrcodekriterium im Hexadezimalformat Virtuelle Hardware

0x002 IP-Adresse

0x004 Datensatz-ID des Datentrdgers mit dem Betriebssystem
0x008 Hostname

0x010 Ethernet-Karte

Lizenzierung des Lizenzmanagers mit dem neuen Sperrcode

Wenn Sie einen stabilen Sperrcode gefunden und eine entsprechende Aktualisierung durchgefiihrt haben,
gibt es keine weiteren spezifischen Lizenzierungsschritte fiir virtuelle Umgebungen. Beenden Sie die Ins-
tallation der Lizenz iiber die Eingabeaufforderung.

Installieren einer Lizenz liber die Eingabeaufforderung

Sie haben zwei Moglichkeiten zur Installation iiber die Eingabeaufforderung. Sie kénnen mithilfe von /i-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie konnen mithilfe von echoid
manuell eine Lizenz beziehen.

Verwenden von 'licenseactivator' zur automatischen Installation einer Lizenz

Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
miissen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie in|,Manuelles Installieren|
piner Lizenz” auf Seite 7|

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nageradministrators. Dies ist das Verzeichnis, in dem Sie den Lizenzmanageradministrator installiert ha-
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ben, nicht das Installationsverzeichnis von IBM SPSS Statistics. Wenn Sie die Standardposition unter
Windows akzeptiert haben, priifen Sie den Ordner C:\Programme (x86)\IBM\SPSS License Tools\
9.7.0.0.

3. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie Folgendes
an der Eingabeaufforderung ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)
licenseactivator <Autorisierungscode>

Dabei ist <Autorisierungscode> Ihr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefiigt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie in [,Manuelles Installieren einer Lizenz”}

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, konnen Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.

Verwenden von 'licenseactivator' mit Autorisierungscodes

licenseactivator wird in der Regel mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.

[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]
* Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.

* Die Proxy-Einstellungen sind optional, aber sie sind unter Umstédnden nétig, wenn sich Thr Computer
hinter einem Proxy befindet. Welche Proxy-Einstellungen benétigt werden, hdangt von der jeweiligen
Proxy-Konfiguration ab. Moglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer fiir die Internetverbindung iiber den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID fiir den Proxy.

PROXYPASS
Falls erforderlich, das Kennwort fiir die Benutzer-ID

Verwenden von 'licenseactivator' mit Lizenzcodes

Eventuell hat Ihnen IBM eine Lizenz gesendet.

* Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.

* Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie
keine Proxy-Informationen angeben miissen.

Manuelles Installieren einer Lizenz

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nageradministrators. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanageradministrator
installiert haben, nicht das Installationsverzeichnis von IBM SPSS Statistics. Wenn Sie die Standardpo-
sition unter Windows akzeptiert haben, priifen Sie den Ordner C:\Programme (x86)\IBM\SPSS License
Too1s\9.7.0.0.
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3. Rufen Sie den Sperrcode fiir den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid
(Windows) oder ./echoid (andere Plattformen) ein.

4. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und
teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschlieffend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

5. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Hinzufligen einer Lizenz

Eventuell mochten Sie zu einem spateren Zeitpunkt eine Lizenz hinzufiigen. Der Vorgang beim Hinzufii-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.

Anzeigen der Lizenz

Sie kénnen Ihre Lizenz fiir gleichzeitig angemeldete Benutzer (einschliefdlich der Anzahl der Benutzer) in
der Anwendung WImAdmin anzeigen. Informationen zur Anwendung WImAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie in [,Verwalten der Lizenz fiir gleichzeitig angemeldete Benutzer”|

huf Seite 13

Testen des Lizenzmanagers

Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.

1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen Computer installiert haben, ins-
tallieren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen mochten,
nicht lauft. Weitere Informationen finden Sie in |, Installieren des Lizenzmanageradministrators” auf]

2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen mochten, nicht ausgefiihrt wird. Weitere Informationen finden Sie in |, Installiere
[des Lizenzmanagers unter Windows” auf Seite 3|

3. Starten Sie die Anwendung WImAdmin. Weitere Informationen finden Sie in [, Starten der Anwendung]
[WImAdmin” auf Seite 13|

4. Fiigen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen mochten. Weitere Informatio-
nen finden Sie in [,Hinzufiigen eines Servers” auf Seite 13|

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie in
[Details zu einer Lizenz” auf Seite 14

Wenn Sie die Lizenzen anzeigen konnen, ist der Lizenzmanager bereit, dass lokale Desktop-Computer an-
geschlossen werden. Sie konnen mit der Installation des Produkts auf lokalen Desktop-Computern begin-
nen. Wenn Sie die Lizenzen nicht anzeigen kénnen, {iberpriifen Sie die vorhergehenden Schritte, um si-
cherzustellen, dass der Lizenzmanager korrekt installiert wurde.

Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager iiber VPN wird nicht offiziell unter-
stiitzt.

Fiir die lokale Installation des vollstindigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfiigung: Sie kdnnen auf jedem Computer eine manuelle Installation durchfiihren
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzufiihren. Sie haben aufierdem die Mdoglichkeit, eine unbeaufsichtigte Installation
unter Mac und Linux durchzufiihren.
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Durchfiihren einer manuellen Installation auf einem lokalen Desktop-Computer

1. Stellen Sie die Installationsmedien zur Verfiigung. Laden Sie das elmage fiir das Produkt herunter
und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk. Wenn Sie tiber Installationsda-
tentrdger verfiigen, erstellen Sie die bendtigte Anzahl von Kopien der DVD/CD oder speichern Sie
die entsprechenden Dateien auf einem freigegebenen Netzlaufwerk

2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen
Sie die benétigte Anzahl von Kopien der Installationsanweisungen fiir das Produkt. Die Installations-
anweisungen stehen auf der Download-Site bzw. im Falle von physischen Installationsmedien im Ver-
zeichnis /Documentation/<Sprache>/InstallationDocuments auf der DVD/CD zur Verfiigung. Suchen Sie
nach den Anweisungen, die Ihrem Lizenztyp entsprechen. Nach der Installation miissen die Endbe-
nutzer die IP-Adresse oder den Namen des Netzcomputers eingeben, auf dem der Concurrent License
Manager ausgefiihrt wird. Tragen Sie diese Informationen an der dafiir vorgesehenen Stelle am An-
fang der Anweisungen ein, bevor Sie diese kopieren.

3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die herun-
tergeladene Datei (bzw. den Netzspeicherort oder die Installations-DVD/CD), die Installationsanwei-
sungen und die Lizenzinformationen an die Endbenutzer, die auf den Computern bei Bedarf manuell
installieren koénnen.

Ubertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Statistics-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, konnen Sie
die Installation automatisch auf die Desktop-Computer der Endbenutzer iibertragen.

Ubertragen einer Installation an Windows-Computer

Das Ubertragen einer Installation ist eine Methode fiir die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden miissen. Sie konnen eine vollstindige Ins-
tallation von IBM SPSS Statistics auf die Computer der Endbenutzer unter Windows iibertragen. Die fiir
die automatische Ubertragung der Installation verwendete Technologie muss die Engine von MSI 3.0 oder
hoéher unterstiitzen.

Anmerkung: Die Ubertragung einer Installation steht fiir Mac und Linux nicht direkt zur Verfiigung.
Stattdessen konnen Sie eine unbeaufsichtigte Installation durchfithren. Weitere Informationen finden Sie
in |, Ausfiihren einer unbeaufsichtigten Installation auf Mac- und Linux-Computern” auf Seite 12|

Deinstallieren einer friiheren Version

Wenn Sie die automatische Ubertragung in ein Verzeichnis durchfiihren, in dem eine frithere Version von
IBM SPSS Statistics installiert wurde, muss die alte Version deinstalliert werden. Sie konnen die Deinstal-
lation ebenso wie eine Installation iibertragen. Weitere Informationen finden Sie in |, Automatische Uber-|
tragung einer Deinstallation” auf Seite 12}

Eigenschaften fiir automatisch libertragene Installationen

Nachfolgend finden Sie die Eigenschaften, die fiir automatisch iibertragene Installationen verwendet wer-
den konnen. Bei allen Eigenschaften wird zwischen Grof3- und Kleinschreibung unterschieden. Werte
miissen in Anfiithrungszeichen angegeben werden, wenn sie Leerzeichen enthalten.
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Tabelle 1. Eigenschaften fir automatisch (bertragene Installationen.

Eigenschaft Beschreibung Giiltige Werte Standard (sofern zutref-
fend)
INSTALLDIR Das Verzeichnis, in dem Ein giiltiger Pfad, beispiels- | C:\Program Files\IBM\
IBM SPSS Statistics auf dem | weise C:\Statistics. SPSS\Statistics\25

Desktop-Computer des
Endbenutzers installiert
werden sollte. Diese Eigen-
schaft ist optional. Wird sie
nicht angegeben, wird der
Standardwert C:\Program
Files\IBM\SPSS\ Statistics\
25 verwendet.

LICENSETYPE Der Lizenztyp. Bei diesem |Network
Wert wird zwischen Grof3-
und Kleinschreibung unter-
schieden.

LSHOST Die IP-Adresse oder der Eine oder mehrere giiltige
Name des Computers bzw. |IP-Adressen oder Namen
der Computer im Netz, auf |der Computer im Netz.

dem bzw. denen der Mehrere Adressen oder Na-
Concurrent License Mana- |men werden durch Tilden
ger ausgefiihrt wird. getrennt (z. B.
Server1~Server2~Server3).
INSTALLPYTHON IBM SPSS Statistics - Essen- | 1 gibt an, dass IBM SPSS 1

tials for Python installieren. | Statistics - Essentials for
Das Produkt umfasst Py- Python installiert wird.
thon Version 2.7 und 3.4, 0 gibt an, dass IBM SPSS

das IBM SPSS Statistics - Statistics - Essentials for
Integration Plug-in for Py- | Python nicht installiert
thon und eine Reihe von wird.

Python-

Erweiterungsbefehlen, die
Moglichkeiten bieten, die
iiber die mit integrierten
SPSS Statistics-Prozeduren
bereitgestellten Moglichkei-
ten hinausgehen. Weitere
Informationen finden Sie
unter "Integration Plug-in
for Python" im Hilfesystem.

MSI-Dateien

Die Datei IBM SPSS Statistics 25.msi befindet sich im Verzeichnis Windows\SPSSStatistics\<Architektur>
auf der DVD/CD, wobei <Architektur> fiir 32bit oder 64bit steht. Nachdem Sie die Software heruntergela-
den haben, miissen Sie den Inhalt des elmage entpacken, um auf die MSI-Datei zugreifen zu konnen.

Beispiel fiir die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Ubertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Statistics 25.msi" /qn /L*v logfile.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Ubertragen der Installation mithilfe von SMS
Die grundlegenden Schritte fiir die Verwendung von Systems Management Servers (SMS) fiir die automa-
tische Ubertragung (Push) von IBM SPSS Statistics sind folgende:
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1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\SPSSStatistics\
<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, miissen Sie den Inhalt des elmage zunéchst entpacken.

2. Bearbeiten Sie die Datei IBM SPSS Statistics 25.sms im kopierten Verzeichnis. Bearbeiten Sie mithilfe
eines Texteditors den Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzu-
fiigen. Eine Liste der verfiigharen Eigenschaften finden Sie in [,Eigenschaften fiir automatisch {ibertra-|
|zene Installationen” auf Seite 9| Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszeile
angeben.

3. Erstellen Sie ein Paket aus der Datei IBM SPSS Statistics 25.sms und verteilen Sie das Paket an die
Desktop-Computer der Endbenutzer.

Verwenden von Gruppenrichtlinie oder einer @hnlichen Technologie zur automati-

schen Ubertragung der Installation

1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\SPSSStatistics\
<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, miissen Sie den Inhalt des eImage zunéchst entpacken.

2. Mit einer Anwendung wie ORCA konnen Sie die Eigenschaftstabelle in der entsprechenden Datei IBM
SPSS Statistics 25.msi unter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server
SDK, das Sie unter http:/ /www.microsoft.com/downloads| finden, indem Sie nach dem SDK suchen.
Eine Liste der Eigenschaften, die in die Eigenschaftstabelle aufgenommen werden kénnen, finden Sie
in |, Eigenschaften fiir automatisch iibertragene Installationen” auf Seite 9} Achten Sie darauf, dass Sie
die richtige MSI-Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei IBM SPSS Statistics 25.msi und verteilen Sie das Pa-
ket an die Desktop-Computer der Endbenutzer.

Automatische Ubertragung der Installation auf ein nicht englisches System

Sie kénnen sie ohne zusétzliche Spezifikation auf ein nicht englisches System iibertragen. Allerdings sind
dann die Installationsanweisungen (bei der Ubertragung einer interaktiven Installation), die Benutzer-
schnittstelle und die Hilfe auf Englisch. Die Anwender konnen nach der Installation die Benutzerschnitt-
stellensprache umstellen, es steht jedoch keine lokalisierte Hilfe zur Verfiigung.

Sie kénnen die Eigenschaft TRANSFORMS verwenden, um eine der MST-Dateien anzugeben, die auf der
DVD/CD oder im heruntergeladenen elmage vorhanden sind. Die MST-Datei stellt sicher, dass der Instal-
lationsassistent, die Benutzerschnittstelle und die Hilfe in der spezifizierten Sprache erscheinen. MST-Da-
teien sind nicht verfiigbar, wenn Sie IBM SPSS Statistics heruntergeladen haben. Benutzer miissen die
Sprachpakete fiir die lokalisierte Hilfe manuell installieren und die Benutzerschnittstellensprache in dem
Produkt manuell dndern.

Die Eigenschaft TRANSFORMS ist ein Parameter fiir MsiExec.exe. Das folgende Beispiel verwendet die Eigen-
schaft TRANSFORMS zur automatischen Ubertragung einer franzésischen Installation. Der Installationsassis-
tent erscheint auf franzosisch, die Benutzerschnittstelle erscheint auf franzosisch und die Hilfe wird auf
franzosisch installiert. (Sie konnen die Sprache der Hilfefunktion auch mit der Eigenschaft HELPCHOICE
iiberschreiben. Weitere Informationen finden Sie in |, Eigenschaften fiir automatisch iibertragene|
[nstallationen” auf Seite 9}) Geben Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Statistics 25.msi" /qn /L*v Protokolldatei.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver" TRANSFORMS=1036.mst

Die folgenden Sprach-MST-Dateien befinden sich im Verzeichnis Windows\SPSSStatistics\<Architektur>
auf der DVD/CD, wobei <Architektur> fiir 32bit oder 64bit steht. Wenn Sie ein elmage heruntergeladen
haben, befinden sich diese Dateien im Stammverzeichnis der entpackten eImage-Dateien.

Tabelle 2. MST-Sprachdateien.

Sprache MST-Datei
Deutsch 1031.mst
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Tabelle 2. MST-Sprachdateien (Forts.).

Sprache MST-Datei
Englisch 1033.mst
Franzosisch 1036.mst
Italienisch 1040.mst
Japanisch 1041.mst
Koreanisch 1042.mst
Polnisch 1045.mst
Russisch 1048.mst
Spanisch 1034.mst
Traditionelles Chinesisch 1028.mst
Vereinfachtes Chinesisch 2052.mst

Automatische Ubertragung einer Deinstallation

Hinweis: Wenn Sie den Deinstallationsbefehl automatisch tibertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benétigen, konnen Sie diese aus der Vertei-
lung ausschlieffen und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Statistics automatisch iibertragen, sollten
Sie gegebenenfalls zuerst eine Deinstallation durchfiihren. Sie kénnen dies im Hintergrund durchfiihren
lassen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch tibertragen. Geben Sie den

gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /X{4762AE15-E5A3-43BF-8822-1CFC70FB147A} /qn /L*v Protokolldatei.txt
ALLUSERS=1 REMOVE="ALL"

Dieser Befehl deinstalliert IBM SPSS Statistics 25. In der folgenden Tabelle sind die Deinstallations-IDs

fiir diese und frithere Versionen aufgelistet.

Tabelle 3. Deinstallations-IDs fiir IBM SPSS Statistics.

Version | Deinstallations-ID

24.* {4762 AE15-E5A3-43BF-8822-1CFC70FB147A}
23.% {C3BA73A4-2A45-4036-8541-4F5F8146078B}
22.* {104875A1-D083-4A34-BC4F-3F635B7FSEF7}
21.% {1E26B9C2-ED08-4EEA-83C8-A786502B41E5}
20.* {2AF8017B-E503-408F-A ACE-8A335452CAD2}
19.* {06C43FA A-7226-41EF-A05E-9AE0A A849FFE}
18.% {C25215FC-5900-48B0-B93C-8D3379027312}
17.0.2 | {2ECDE974-69D9-47 A9-9EB0-10EC49F8468A}
17.0.1 | {46B65150-F8A A-42F2-94FB-2729 ASAESF7E}
17.0.0

16.* {621025AE-3510-478E-BC27-1A647150976F}

Ausfuhren einer unbeaufsichtigten Installation auf Mac- und Linux-

Computern

Eine unbeaufsichtigte Installation erfolgt ohne grafische Benutzeroberflache und erfordert keine Eingriffe
seitens des Benutzers. IBM SPSS Statistics enthélt eine Datei mit den Eigenschaften fiir das Installations-
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programm, mit der Sie diese Art von Installation auf Mac OS- und Linux-Computern durchfiihren kén-
nen. Die Datei enthilt verschiedene Optionen und Beschreibungen zu diesen Optionen.

Verwendung der Datei 'installer.properties'

Die Datei mit den Eigenschaften fiir das Installationsprogramm, installer.properties, befindet sich in /Linux/
Administration oder /MacOS/Administration im Stammverzeichnis der DVD/CD. Wenn Sie ein eImage he-
runtergeladen haben, befindet sich installer.properties im Ordner Administration des elmage.

1. Kopieren Sie die Datei 'installer.properties' von der DVD/CD oder vom elmage.
2. Offnen Sie die kopierte Datei in einem Texteditor.

3. Andern Sie die benétigten Eigenschaften. Einige Optionen benétigen einen Zeichenfolgewert, andere
dagegen, die einer Auswahl im Installationsassistenten entsprechen, konnen auf 0 (aus) oder 1 (an) ge-
setzt werden.

Ausfihren einer unbeaufsichtigten Installation

Stellen Sie bei Installationen unter Mac OS sicher, dass die unbeaufsichtigte Installation und nicht die in-
teraktive Installation durchgefiihrt wird. Die unbeaufsichtigte Installation weist die Erweiterung .bin auf
und kann als elmage heruntergeladen werden. Wenn Sie {iber Installationsdatentrdger verfiigen, befindet
sie sich auf der DVD/CD unter /MacOS/Administration/.

Anmerkung: Damit das Programm fiir die unbeaufsichtigte unter Mac OS ausgefiihrt werden kann, muss
Java installiert sein. Die aktuellen Informationen zu Systemanforderungen finden Sie in den Berichten mit
den detaillierten Systemanforderungen auf der Site des IBM Technical Support unter |Ettp:/ / |
publib.boulder.ibm.com /infocenter /prodguid /v1r0/clarity /softwareRegsForProduct.html|

1. Fiihren Sie in einer Terminalanwendung die Installation mit dem Schalter -f aus, gefolgt vom Spei-
cherort der Datei 'installer.properties’ in Anfithrungszeichen. Unter Mac OS und Linux muss die Aus-
fiihrung als 'Root’ oder mit dem Befehl sudo erfolgen. Es folgt ein Beispiel unter Linux:

sudo ./setup.bin -f "/root/installer.properties"”

Verwalten der Lizenz fir gleichzeitig angemeldete Benutzer

Der Lizenzmanager verwaltet die Lizenz fiir gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WImAdmin, die die Hauptbenutzeroberflache fiir den Lizenzmanageradministrator ist, konnen Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen fiir gleichzeitig angemeldete
Benutzer anzeigen. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-System oder einem Remo-
te-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator auf einem separaten Win-
dows-System. Weitere Informationen finden Sie in |, Installieren des Lizenzmanageradministrators” auf]

Anmerkung: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die
zusammen mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation finden Sie im
Verzeichnis help\Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.
C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0\help\Content).

Starten der Anwendung WImAdmin

Wihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:

[Alle] Programme > IBM > SPSS License Tools > <Version> > Sentinel RMS Server Administration

Hinzuflgen eines Servers

Bevor Sie einen Lizenzmanager verwalten kénnen, miissen Sie in der Anwendung WImAdmin einen Ser-
ver dafiir hinzufiigen. Sie haben zwei Optionen, um den Server hinzuzufiigen.
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Manuelles Hinzufiigen eines Servers
1. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Defined Server List

2. Geben Sie in dem Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein,
auf dem der Lizenzmanager lduft.

3. Klicken Sie auf Add.
4. Klicken Sie auf OK.

Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WImAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Subnet
Servers.

Eine Liste von Servern fiir Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fiigen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen

Wenn Endbenutzer beim Abruf von Lizenzen Schwierigkeiten haben, kénnen die Protokolldateien mogli-
cherweise hilfreiche Informationen enthalten. Sie kénnen die Umgebungsvariable LSERVOPTS sowie die
Optionen -f <Traceprotokolldatei> und -1 <Nutzungsprotokolldatei> verwenden, um anzugeben, dass
Protokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den
zugehorigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des Installations-
verzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz

Sie kénnen Details zu Lizenzen anzeigen, die Sie entweder manuell oder iiber den Lizenzierungsassisten-
ten hinzugefiigt haben.

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Lizenzma-
nagerserver, um die Lizenz(en) anzuzeigen.

2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-
zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.

Anzeigen der mit den Funktionscodes verkniipften Namen

1. Wechseln Sie tiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Tmshowlic <Server> (Windows) oder ./Imshowlic <Server> (andere Betriebssysteme) ein.

Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausge-
fiihrt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgefiihrt, die
auf dem Server verfiigbar sind.

Einrichten von redundanten Lizenzservern

Sie konnen mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstiitzen. Mit redun-
danten Servern kénnen Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung iiberneh-
men.
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Fiir die in den folgenden Schritten beschriebene Aktivierung der Redundanzfunktion benétigen Sie einen
speziellen Lizenzcode. Wenden Sie sich fiir Unterstiitzung beim Erstellen eines redundanten Lizenzschliis-
sels oder bei anderen Fragen zur Lizenzierung telefonisch oder per Mail an den IBM Support. Kontaktin-
formationen finden Sie unter |http:/ /www.ibm.com/planetwide]

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgefiihrt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, miissen von diesen zwei ausgefiihrt werden.

Vorbereiten der einzelnen redundanten Lizenzserver

1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie in |,,Installieren des Concurrentl
[License Managers” auf Seite 2|

2. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

3. Rufen Sie den Sperrcode fiir die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-
rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.

4. Notieren Sie den Sperrcode. Fiir die nédchsten Schritte ist der Sperrcode erforderlich.
5. Wiederholen Sie diese Schritte fiir jeden redundanten Lizenzserver.

Aktivieren der redundanten Lizenzen
1. Rufen Sie das IBM SPSS License Key Center auf (https:/ /spss.subscribenet.com /control /ibmp /login).
2. Erstellen Sie einen Autorisierungscode fiir gleichzeitig angemeldete Benutzer.

3. Klicken Sie nach der Erstellung des Autorisierungscodes fiir gleichzeitig angemeldete Benutzer auf
den Code und bldttern Sie nach unten, bis die Felder fiir Sperrcode angezeigt werden. Nun kénnen
Sie dem Lizenzschliissel mehrere Sperrcodes hinzuftigen.

4. Geben Sie die Sperrcodes aus den vorherigen Schritten in die entsprechenden Felder ein.
5. Klicken Sie auf Ubergeben.

Einrichten eines Pools mit redundanten Lizenzservern

1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgefiihrt wird, be-
enden Sie diesen auf jedem betroffenen Computer.

2. Wihlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Redundant License File
Dadurch wird die Anwendung WrlfTool geoffnet.

3. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > New

4. Klicken Sie fiir jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der priméare Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufiigen, die Sie vom Kundendienst oder IThrer
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefiigt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschlieSend auf Done.

Speichern der redundanten Lizenzdatei
1. Wahlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > Save As

2. Speichern Sie die redundante Lizenzdatei (Iservrlf) an einem leicht zugédnglichen Speicherort. In den
néchsten Schritten miissen Sie die Datei kopieren.
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Konfigurieren der redundanten Lizenzserver

1. Kopieren Sie die redundante Lizenzdatei (Iservrlf) unter Windows in den Unterordner winnt des Li-
zenzmanagerinstallationsverzeichnisses. Wenn Sie die Standardposition akzeptiert haben, wechseln Sie
in den Ordner C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager.
Auf anderen Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsver-
zeichnis. Es miissen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.
Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt installiert, gibt der Benutzer alle redundanten Server an. Die Namen
oder IP-Adressen der Server werden dabei durch Tilden getrennt (z. B. Serverl~Server2~Server3). Das
Setup-Programm fiigt dann dem Computer des Endbenutzers die erforderlichen Konfigurationsinformati-
onen hinzu. Wenn das Produkt bereits auf den Computern installiert ist, konnen Sie die folgenden Schrit-
te ausfiihren, um die Konfigurationsinformationen hinzuzufiigen. Sie kénnen auch zunéchst eine Deins-
tallation und anschlieend eine neue Installation {ibertragen, bei der alle Server festgelegt sind.
Informationen zum automatischen Ubertragen von Installationen finden Sie in [, Ubertragen einer Installa-|
tion an Windows-Computer” auf Seite 9|

1. Offnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet sich diese Datei auf
dem Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese
Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis
bin des Produktinstallationsverzeichnisses.

2. Andern Sie den Wert von DAEMONHOST in die durch eine Tilde (~) getrennten Namen oder IP-Adressen
des Servers. Beispiel:
DAEMONHOST=Serverl™Server2™Server3

3. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen

Mit Pendlerlizenzen konnen Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden konnen, auch wenn sie nicht mit dem Netz verbunden sind. Unter Windows sind
Pendlerlizenzen standardmaflig nicht aktiviert. Auf anderen Betriebssystemen sind sie dagegen standard-
méfig aktiviert. Anweisungen fiir das eigentliche Auschecken der Pendlerlizenz finden sich in den Instal-
lationshinweisen fiir Endbenutzer.

Sie kénnen den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschranken, die fiir den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschranken. Damit
wird verhindert, dass sich alle verfiigbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
zur Verfligung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie konnen auflerdem
die Dauer festlegen, fiir die mobile Lizenzen ausgecheckt werden kénnen. In der Standardeinstellung be-
trdgt die maximale Dauer 7 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primére
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des priméren Li-
zenzservers konnen die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfligbaren Pendlerlizenzen

1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-
se Variable wird unter Windows wéhrend der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur fiir die anderen Betriebssysteme durchfiihren miissen.

2. Andern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Hierbei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
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Lizenzen angibt, die fiir den mobilen Zugriff verfiigbar sind. Mit der Angabe 0 stehen keine Lizenzen
fiir den mobilen Zugriff zur Verfiigung. Dieser Schalter ist unter Windows standardmaéflig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgefiihrt wird.
Festlegen der maximalen Zeitdauer flir Pendlerlizenzen

Die maximale Zeitdauer, fiir die die Endbenutzer eine Pendlerlizenz auschecken konnen, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Un-
ter Mac OS befindet sich diese Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese
Datei im Unterverzeichnis bin des Produktinstallationsverzeichnisses. Offnen Sie die Datei spssprod.inf und
suchen Sie nach CommuterMaxLife . Legen Sie den Wert dieser Option auf die maximale Anzahl von Tagen
fest, fiir die die Endbenutzer eine Pendlerlizenz auschecken konnen. Der Wert sollte eine Zahl zwischen 1
und 30 sein. Sie konnen diesen Wert auch festlegcen, wenn Sie die Installation automatisch iibertragen.
Weitere Informationen finden Sie in |, Ubertragen einer Installation an Windows-Computer” auf Seite 9|

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9.00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behdlt der Benutzer die Lizenz tatsichlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie koénnen ermitteln, welche Benutzer Lizenzen ausgecheckt haben.

1. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Ismon<Server> (Windows) oder ./1smon <Server> (andere Betriebssysteme) ein. Dabei stellt
<Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausgefiihrt wird.
Sie konnen den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen fiir
den Server "localhost" anzeigen méchten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WimAdmin

Sie konnen ausgecheckte Lizenzen auch in der Anwendung WImAdmin anzeigen:

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben dem Li-
zenzmanagerserver.

2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz fiir gleichzeitig angemeldete
Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz fiir gleichzeitig angemeldete Benutzer.

3. Waihlen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Uberpriifen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen

Sie konnen eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen fiir bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie konnen zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz fiir eine Gruppe von Hauptbenutzern reserviert wird. Fiir diese Benutzer werden
die Lizenzen immer verfligbar sein. Mithilfe der Reservierungen kénnen Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.
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Erstellen einer neuen Reservierungsdatei

1.

2.

Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:

Edit > Reservation File

Dadurch wird die Anwendung 'Wlsgrmgr' geoffnet.

Wihlen Sie die folgenden Befehle aus den Meniis der Anwendung 'Wlsgrmgr' aus: File > New.

Hinzufligen von Lizenzen und Benutzer zur Reservierungsdatei

1.

Wihlen Sie die folgenden Befehle aus den Meniis der Anwendung 'Wlsgrmgr' aus:
Feature > Add
Klicken Sie im ersten Bildschirm des Assistenten auf Weiter.

Geben Sie den Funktionscode fiir die entsprechende Lizenz an, die Sie reservieren mochten. Informati-
onen zum Abrufen der Funktionscodes fiir die entsprechenden Lizenzen finden Sie in
[Details zu einer Lizenz” auf Seite 14} Legen Sie aufSerdem eine bestimmte Version fest. Geben Sie die
Version hierbei so ein, wie sie in der Anwendung 'WIAdmin' angezeigt wird (z. B. 160). Die Version
ist nicht optional. Ignorieren Sie die Steuerelemente fiir "Capacity”, weil Lizenzen dieses Typs nicht
unterstiitzt werden.

Klicken Sie auf Weiter.

Geben Sie fiir die Gruppe von Benutzern einen Namen an. Der Name ist willkiirlich, er sollte jedoch
aussagekriftig sein (z. B. Vertrieb).

Geben Sie die Anzahl der Lizenzen an, die fiir diese Gruppe reserviert werden sollen. Die Gruppen-
mitglieder konnen auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr fiir die Benutzer zur Verfiigung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie von 10 Lizenzen 5 Lizenzen reservieren, konnen Mitglieder dieser Gruppe iiber 10
Lizenzen verfiigen, wiahrend den anderen Benutzern nur 5 Lizenzen zur Verfligung stehen.

Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehorigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
horen, konnen die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehoren, konnen nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschliefsen miissen.
Daher kénnen verschiedenen Gruppen fiir dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

Klicken Sie auf Fertigstellen, wenn Sie der Gruppe alle Benutzer hinzugefiigt haben.

Fiigen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie kénnen Lizenzen und Gruppen
auch dndern oder 16schen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswéhlen.

Speichern der Reservierungsdatei

1.

18

Wihlen Sie folgenden Befehle aus den Meniis aus, wenn Sie die Reservierungsdatei fertiggestellt ha-
ben:

File > Save As
Speichern Sie die Datei an einem leicht zugédnglichen Speicherort. Im ndchsten Schritt miissen Sie die
Datei kopieren.

Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei Isreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Lizenzmanagerinstallations-
verzeichnis. Wenn Sie die Standardposition akzeptiert haben, wechseln Sie in den Ordner
C:\Programme (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager. Auf anderen
Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsverzeichnis.

Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen mochten, kopieren Sie die
Reservierungsdatei (Isreserv) auf jeden Server.

Starten Sie abschlieffend jeden Lizenzmanager neu.

IBM SPSS Statistics Version 25: Lizenz fiir gleichzeitig angemeldete Benutzer - Administratorhandbuch



Starten und Stoppen des Lizenzmanagers

Die Methode zum Starten des Lizenzmanagers hingt von Ihrem Betriebssystem ab.
Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgefiihrt. Der Dienst wird stan-
dardméflig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten miissen, gehen Sie wie
folgt vor:

1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.

2. Doppelklicken Sie auf Dienste.

3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Starten oder Been-
den aus.

Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Damonprozess ausgefiihrt. Fithren Sie zum
manuellen Starten die folgenden Schritte aus. Sie kdnnen den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).

1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

2. Starten. Geben Sie als Root an der Eingabeaufforderung ./1serv & ein und driicken Sie die Eingabe-
taste.

3. Beenden. Geben Sie als Root ./1srvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-
me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgefiihrt wird. Driicken Sie
dann die Eingabetaste.

Konfigurieren des Lizenzmanagers fiur den automatischen Start
Windows

1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.

Doppelklicken Sie auf Dienste.

Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Eigenschaften aus.
Legen Sie als "Starttyp" Automatisch fest.

Klicken Sie auf OK.

S Sl < A

Andere Betriebssysteme
1. Fiigen Sie einer der Startdateien des Betriebssystems den Eintrag ./1serv & hinzu.

Deinstallieren des Lizenzmanagers
Windows
1. Wahlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:
Einstellungen > Systemsteuerung
2. Doppelklicken Sie auf Software.
3. Wahlen Sie Sentinel RMS License Manager und klicken Sie anschlieffend auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.

Andere Betriebssysteme

1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
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2. Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./1srvdown
<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgefiihrt wird. Driicken Sie dann die Eingabetaste.

3. Loschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators

1. Waihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:
Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.

3. Waihlen Sie License Tools aus und klicken Sie anschlieffend auf Entfernen.

4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.

Fehlerbehebung bei Problemen mit den Desktop-Computern

Gehen Sie folgendermafien vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden kénnen:

1. Fiihren Sie 1swhere aus, um zu tiberpriifen, ob der Desktop-Computer den Netzcomputer finden
kann, auf dem der Lizenzmanager ausgefiihrt wird. Weitere Informationen finden Sie in

on "Iswhere"”|

2. Stellen Sie sicher, dass der Lizenzmanagerservice auf dem Netzcomputer ausgefithrt wird.

3. Uberpriifen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem
Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese Datei
im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis bin des
Produktinstallationsverzeichnisses. Offnen Sie die Datei spssprod.inf und stellen Sie sicher, dass fiir
DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers festgelegt ist, auf dem der
Lizenzmanager ausgefiihrt wird. Wenn Sie redundante Server einsetzen, miissen alle Namen bzw. IP-
Adressen angegeben werden. Die einzelnen Namen werden durch eine Tilde (™) getrennt. Wenn es
sich beispielsweise bei den Lizenzmanagercomputern um SERVERI, SERVER2 und SERVER3 handelt,
wird DAEMONHOST auf SERVERIVSERVER2VSERVER3 gesetzt.

Ausfuhren von "Iswhere"
Iswhere kann {iber den Desktop-Computer eines Endbenutzers ausgefiihrt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgefiihrt wird.

1. Wechseln Sie per Eingabeaufforderung in folgendes Verzeichnis:
*  Windows. <Installationsverzeichnis>
*  Mac OS. <Installationsverzeichnis>/<Produkt>.app/Contents/bin
* Linux. <Installationsverzeichnis>/bin
2. Geben Sie Tswhere (Windows) bzw. ./1swhere (Linux und Mac) ein.

Service und Support

Um den Technical Support von IBM zu kontaktieren, rufen Sie |http://www.ibm.com/support] auf und
senden Sie eine Fallbeschreibung. Sie miissen sich beim Technical Support von IBM registrieren, falls Sie
das nicht schon friiher getan haben.

IBM bietet auflerdem regelmifsig 6ffentliche Schulungsseminare fiir IBM Produkte. Die Ausbildung kann
auch bei Ihnen vor Ort erfolgen. Informationen zu Schulungsseminaren finden Sie unter
www.ibm.com /training /spss}
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